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Release Notes
These release notes give an overview of the differences between OPNET IT Guru Release 11.5 and the 
previous release. If you are upgrading from a previous release, you should review this document.

Because release notes are sometimes updated after the product documentation is distributed, visit the 
OPNET website (www.opnet.com/support) often to check for the newest version of these release notes 
and previous release notes.
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Release Notes
Release 11.5 Description

OPNET IT Guru 11.5 is a significant software update to the OPNET 11.0 
software release. This release contains many new features and enhancements 
to existing capabilities. This release also implements suggestions and fixes 
many software problems reported in earlier releases.

System Requirements

Be sure to check the latest system requirements on the OPNET website:

www.opnet.com/support

GUI Enhancements

Object Palette Enhancements

The Object Palette has been enhanced to present all available network object 
models in a tree. You can drag objects directly from the tree view in the same 
way that you drag objects from the icon view of the Object Palette. However, the 
Object Palette tree view offers the following additional features:

• View multiple palettes in the same window

• Configure palettes using right-click menu operations

• Display logical groupings of models for quick selection

• Access Device Creator to create custom models

This tree view is now the default style of the Object Palette. You can switch 
between the tree view and the icon view. Also, you can set the icon view to be 
the default style by changing the value of a preference. For details, see 
network_palette.style  on page ITR-2-62 of the Reference Guide.

For more information about the Object Palette, see Object Palettes on 
page ITU-6-10 of the User Guide.

Network Browser Enhancements

The Network Browser has been enhanced to expand its ease-of-use. The new 
features are as follows:

• When you open the Network Browser, your previous option selections are 
“remembered”. This enhancement allows you to continue using the settings 
that you previously defined. (Note that search strings and selected objects 
are not “remembered”.)
RN-11.5-4 IT Guru/Release 11.5
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• The checkbox options on the Network Browser can be hidden to save space. 
To display or hide the checkbox options, click the Settings button. By default, 
the checkbox options are hidden. Additionally, a new checkbox option has 
been added—Expand Tree. Using this checkbox expands the Network 
Browser tree to display nodes and links.

• The view filter includes new options that organize networks logically, rather 
than hierarchically. The following arrangements are available:

— BGP AS numbers—Arranges nodes by Autonomous System Number.

— Device types—Arranges nodes by device type.

— IP subnetworks—Arranges nodes by IP subnetwork.

— OSPF areas—Arranges nodes by OSPF address.

When arranged by IP subnetworks or OSPF areas, nodes are identified 
by IP address, node name, and interface name. When you select a 
node, all interfaces for that node are selected.

— Routing protocols—Arranges nodes by routing protocol. 

— Vendor and chassis types—Arranges nodes first by vendor, then by 
chassis type.

• After importing nodes (for example, device configuration imports (DCI) or 
VNE Server imports (VNESI)), the Network Browser can be set to open 
automatically depending on the total number of nodes in the project. Having 
the Network Browser open after an import can help you find specific nodes, 
especially if the network is large. The minimum number of nodes for which to 
automatically open the Network Browser is specified with a preference. For 
details about this preference, see show_network_browser_threshold on 
page ITR-2-71 of the Reference Guide.

For more information about the Network Browser, see Network Browser on 
page ITU-7-26 of the User Guide.

Flexible Map Visualization for Pacific Region

Subnets can now span the International Date Line. A subnet can be defined with 
a left edge that is west of 180 degrees longitude and with a right edge that is 
east of 180 degrees longitude. This enhancement is set using a preference. For 
details about this preference, see allow_rotated_world_coordinates on 
page ITR-2-48 of the Reference Guide.
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Easier Node Model Selection

Editing the “model” attribute of a node is now easier. Previously, when you 
edited the model attribute of a node, a long list of models appeared. Now, a 
dialog box appears that is similar to the Object Palette Tree View. By default, 
the model being edited is selected in the dialog box. The dialog box makes it 
easier to find and select the model you want. Additionally, you can access model 
details and create custom models.

Create Custom Model Enhancement

The Create Custom Model procedure has been streamlined. You can now 
select a device and define parameters in the same dialog box. For more 
information about creating a custom model, see Creating Custom Models with 
Device Creator on page ITU-6-73 of the User Guide.

Convert Loads to Flows Enhancement

The Convert Loads to Flows operation now provides a graphical interface for 
defining constraint information to use in the Loads to Flows process. Adding 
constraint information can produce more accurate conversion results.

Group Nodes into Subnets and Model Assistant Enhancements

The Group Nodes Into Subnets operation has been replaced with a more 
powerful operation. The new operation includes the following new capabilities:

• Arrange nodes in multi-level subnet hierarchies

• Choose from an expanded list of grouping options, including the ability to 
group by:

— AS number

— OSPF area

— names (using regular expressions or sub-strings)

• Specify layout and aspect ratio of subnets

• Preview grouping before applying it to your project

• Save the grouping settings to a file and later load the file for re-use

• Apply saved grouping settings to a network using the Model Assistant 
operation. (This capability is especially useful when a re-imported network 
includes new nodes.)

For more information, see Group Nodes into Subnets on page ITU-6-60 and 
Model Assistant on page ITU-6-50 of the User Guide.
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Selecting Objects in a Treeview

Selecting multiple objects in a treeview has been enhanced to conform to 
common user interface conventions. To select consecutive objects, click the 
first object, hold down the Shift key, and then click the last item. All objects 
between the first and last objects, inclusive, will be selected.

General Enhancements

Log Viewer

A new log viewer provides a central place from which to view IT Guru logs. It 
replaces the individual viewers formerly used for system and error logs, 
simulation logs, import logs, and so on.

Figure 11.5-1   Log Viewer

The new log viewer has a set of tabs that let you select the type of log you want 
to see. A treeview on the left-hand side of the viewer window lists all available 
logs of the selected type. You can choose to list all logs or only those for the 
current scenario in the treeview.

The log viewer can display two kinds of logs:

• Text-based logs. These logs open in a single pane.

• Event-based logs. These logs open in two panes (as shown in 
Figure 11.5-1). The right-hand pane contains the log data, one event per row. 
Each row has several columns with different information about the event. 
Using the filter treeview in the left-hand log pane (in the center of the viewer 
window), you can restrict the displayed events to only those with specific 
column values.

You can open the log viewer in three ways:

• From the System window:
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Choose Help > Show All Logs. (All available logs are listed.)

• From a Project Editor:

Choose Help > Show All Logs. (Only logs for the current scenario are listed.)

• From a specific menu:

Choose the “show logs” operation from a menu such as DES or 
Flow Analysis. (The corresponding tab is preselected and only logs for the 
current scenario are listed.)

You can open the current log in an advanced log viewer, which provides 
additional capabilities. With event-based logs, for example, you can do the 
following:

• Change which column is used to color-code the log entries and what color is 
used for each unique value in that column.

• Save the current viewer settings.

• Export the log to a text, comma-separated ASCII, HTML, or XML file.

With text-based logs, the advanced viewer provides all the capabilities of a 
text-edit pad, including text searches and saving the log to a different file.

Improved MIF Map Imports

The MIF import parser has been improved to support more MIF file versions. 
Expanded error reporting and an import problem log have also been added. For 
details, refer to MIF Maps on page ITU-7-7 of the User Guide.

License Server Reporting

A new utility lets a license server track license usage statistics and produce 
statistical reports upon request. When tracking is enabled on the license server, 
you can generate reports on any client using two new commands in the 
op_license_util application. Both commands let you specify the number of days 
on which to report.

• fldb_stats—Produces license server statistics, including maximum 
number of concurrent users, maximum number of concurrent licenses in use, 
and average number of concurrent licenses in use.

• license_stats—Produces license file statistics, including license ID 
(license number, contract number and program name), total time in use, 
average checkout time, number of checkouts, number of unique users who 
accessed the file, and user IDs of those who accessed the file.

The report displays on the screen, and a time-stamped .csv copy of the file is 
placed in your <rel_dir>\op_admin\tmp directory.
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Low Memory Warnings

Guru can now provide warnings when available RAM is growing short. A 
warning is triggered when an attempt to allocate memory fails. When this 
happens, the simulation frees any unneeded memory and displays a warning. 

Exporting to Visio

Visio files that are exported from OPNET can only be opened in Visio 2002 and 
Visio 2003. Support for Visio 2000 has been discontinued.

Preferences

The following preferences have been added to IT Guru.

• allow_rotated_world_coordinates—Specifies whether subnets with units and 
360 degree spans should wrap in the x direction. In other words, this 
preference allows units to span the International Date Line.

• flow_spreadsheet_import_filename—Specifies the default file name used 
when importing spreadsheet traffic.

• flow_spreadsheet_import_overwrite—Specifies the default choice for 
overwriting traffic when importing spreadsheet traffic.

•  network_palette.style—Specifies the default style for the Object Palette: 
Tree View or Icon View. The Object Palette Tree View presents network 
object models in a tree and allows access multiple palettes simultaneously. 
The Object Palette Icon View presents network object models with icons and 
allows access to one palette at a time.

• show_network_browser_threshold—Specifies the minimum number of 
nodes in a project after an import for which the Network Browser 
automatically displays.

Device Configuration Import Enhancements

Multiple Directory Support

In previous versions of Guru, you could specify one configuration file directory 
per vendor (Cisco or Juniper). All files for a given vendor had to be placed in the 
specified directory. With this release, you can specify multiple directories per 
vendor, giving you greater flexibility for import. With the new dialog box, shown 
in Figure 11.5-2, you can add, duplicate, or delete rows in the list, or you can 
clear the information in all rows by using the new buttons provided. A Browse 
button lets you select your directories from a directory chooser.
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Figure 11.5-2   Device Configuration Import Dialog Box

Incremental Device Configuration Import over Import from VNE Server

With this release, you can perform an incremental import of device configuration 
files to a network model that was originally imported from VNE Server. This 
gives you the ability to perform “what if” analyses on device configuration files 
by following this workflow:

1) Import your network from VNE Server and include the device configuration 
files.

2) Edit the imported device configurations and save them to new files.

3) Import the changed device configuration files using incremental DCI with 
either the “Reimport configurations for selected devices” or “Reimport 
configurations for modified devices” option. The attributes for affected 
devices are reset to default and new attribute values are applied based on 
information in the configuration files. 

Note—During incremental DCI over a model previously imported from VNE 
Server, no changes affecting topology (such as links and interfaces) are 
applied. The network preserves the links provided by VNE Server during the 
initial import. 

Enhanced Dual MSFC Support

See Dual MSFCs on page RN-11.5-32) for enhanced support for dual Multilayer 
Switch Feature Cards (MSFC) on Cisco 6500 multi-layer switches. For more 
information, see Importing Dual MultiLayer Switch Feature Cards on 
page ITU-10-76 of the User Guide.

Specify vendor(s): 
Cisco, Juniper, or 
both

Specify directory 
path

Specify whether 
or not to include 
subfolders of the 
specified 
directory

Browse available 
directories

Add, duplicate, or 
delete rows, or 
clear all 
information from 
existing rows
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New Supported Show Commands

The following commands are now supported:

• PIX

— show version

• Cisco Catalyst Switches

— show vlan

Preferences

The following new device configuration import preferences are available.

• device_import.collapse_clouds—Specifies whether or not imported clouds 
are viewed as a single cloud by collapsing all subnets or as subnet clouds 
collapsed by protocol. The choices are as follows:

— Don’t Collapse—Default behavior that imports clouds with different IP 
subnets as separate clouds.

— Collapse All—Imports all clouds into a single subnet called “Network 
Cloud”. 

— Collapse per Protocol—Creates cloud nodes in subnets by protocol. ATM 
clouds are collapsed into a subnet called “ATM Cloud”. Frame Relay and 
serial clouds are collapsed into a subnet called “Serial Cloud”.

• device_import.create_serial_cloud—Specifies whether or not to convert a 
cloud that is a mixture of Frame Relay, ATM, and serial into a serial cloud. 
Possible selections are as follows:

— TRUE: The following mix of interfaces is converted to a serial 
cloud—ATM + Frame Relay, ATM + Frame Relay + Serial, ATM + Serial, 
or Frame Relay + Serial. 

— FALSE: ATM + Frame Relay is imported as a combined FR/ATM switch. 
Other connectivity is not inferred.

— PARTIAL: ATM + Frame Relay + Serial, ATM + Serial, or Frame Relay + 
Serial are converted to a serial cloud. ATM + Frame Relay is imported as 
a FR/ATM switch with no conversion necessary.

If Ethernet interfaces are present, no cloud is inferred.

• device_import.tunnel_cloud_import—Specifies whether or not to infer 
Layer-3 IP clouds. Possible selections are as follows:

— TRUE—This is the default value, which will infer Layer-3 IP clouds based 
on the tunnel interface information in the import file.

— FALSE—This option will not infer Layer-3 IP Clouds. Tunnel interfaces 
will not be connected in the network model when there is no information 
about Layer-2 connectivity between the interfaces.
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• device_import.import_voip_configuration—Specifies whether a VoIP device 
is imported as a multi-service switch or as a router. Possible selections are 
as follows:

— ENABLED: (default) If the preference is set to ENABLED, the VoIP 
device is imported as a multi-services switch. All VoIP configurations are 
imported, and attributes are set as expected.

— DISABLED: If the preference is set to DISABLED, the VoIP device is 
imported as a router. All VoIP configurations are ignored, and a message 
is created in the import log.

VNE Server Import Enhancements

Dual MSFC Support

See Dual MSFCs on page RN-11.5-32 for enhanced support for dual Multilayer 
Switch Feature Cards (MSFC) on Cisco 6500 multi-layer switches. For more 
information, see Importing Dual MultiLayer Switch Feature Cards on 
page ITU-10-76 of the User Guide.

Check Point FireWall-1 Modeling

Check Point FireWall-1 devices can now be imported from VNE Server. 
Included in this release are the following:

• New device type—“Check Point (Nokia Appliance)”

• Support for Check Point global properties including implied rules, stateful 
inspection, NAT, and Log and Alert

• Rules in security rule base are mapped to individual access lists in device 
model

• Support for network address translation (NAT) tables

• Support for automatic ARP configuration in NAT

• Support for bi-directional NAT configuration

• Support for anti-spoofing rules

• Routing configuration for RIP and OSPF are set according to the IPSO 
configuration for Nokia appliances

• Nokia IPSO access lists are imported as packet filters

• Translation tables support NAT usage in simulations using either Flow 
Analysis or DES

For more information about importing Check Point FireWall-1 devices, see 
Importing Check Point FireWall-1 on page ITU-10-53 of the User Guide.
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Nortel Contivity Support

This version includes limited support for Nortel Contivity VPN gateways. 
Supported features include the following:

• Routing and network addressing

• Branch-office VPN tunnels

• IPSec

• WAN services, including PPP and Frame Relay

Features that are not supported in this release include stateful firewall, QoS, 
and user tunnels.

Preferences

Three new or modified preferences support VNE Server import:

• vne_import.tunnel_cloud_import

• vne_import.import_voip_configuration

• vne_import.create_serial_cloud 

For details, see the descriptions of the similarly named DCI Preferences on 
page RN-11.5-11.

Network Difference Report Enhancements

IT Guru includes a new Network Difference Report. Use the new network 
difference report to identify real-world network differences between two network 
scenarios, such as network protocol and device configuration. Network 
difference reports are useful when you want to know exactly how a network has 
evolved from one scenario to the next or how networks imported from different 
sources vary. Specifically, the new network difference report identifies the 
following:

• Device configuration settings for routers, switches, and firewalls

• Logical groups, such as BGP Autonomous System, EIGRP Autonomous 
Systems, and OSPF Areas

You can access the new network difference report by choosing Scenarios > 
Network Difference Report. The previously available network difference report 
and live network difference report have been renamed “Object/Attribute 
Difference Report” and “Live Object Attribute Difference”, respectively, and are 
available from the Scenarios menu.
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Don’t confuse the Network Difference Report and the Object/Attribute 
Difference Report.

• A Network Difference Report identifies only those differences that are likely 
to affect network behavior, such as differences in network topology and 
device configurations.

• An Object/Attribute Difference Report identifies all differences in objects and 
attributes, regardless of whether those differences affect network behavior.

Note—When using the Automation module, any 11.0 or earlier automation files 
created for the Network Difference Report (renamed Object/Attribute Difference 
Report in 11.5) will still work as expected. In 11.5, the user interface will display 
the old files under the new name. However, to avoid confusion, the label in the 
task scheduler dialog box has been changed. Older network difference 
automation files are converted to the new format automatically and are labeled 
“Generate Object/Attribute Difference Report”. (Previously, these were labeled 
“Generate Network Difference Report”.)

Note—If using Report Server 2.0 or earlier, Object/Attribute Difference reports 
will be listed only under the product-specific folder. On the Report Server web 
page, click on View by Products and then the product name.

For more information about the new network difference report, see Network 
Difference Reports on page ITU-15-17 of the User Guide.

For more information about the Object/Attribute Difference Report (formerly the 
Network Difference Report) operation, see Object/Attribute Difference Reports 
on page ITU-15-19 of the User Guide.

For more information about the Live Object/Attribute Difference (formerly the 
Live Network Difference) operation, see Live Object/Attribute Differences on 
page ITU-7-37 of the User Guide.
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Traffic Import Enhancements

Unmapped Traffic Flows

With this release, you can assign unmapped traffic flows at any time after the 
initial import. In prior releases, you had to match unmapped traffic flows to 
specific nodes using the Unrecognized Traffic Assistant and then reimport the 
traffic. Unmapped traffic flows are now saved with the network model.

Note—Unmapped traffic flows do not affect design, analysis, or validation 
results. They must be assigned to specific nodes to have an effect.

New Unmapped Traffic Workflow

Any time after the initial import, you can view the unmapped traffic in the Flows 
Browser. By selecting the Show Unmapped Traffic checkbox in the Flows 
Browser (see Figure 11.5-3), you can assign the unmapped traffic. This release 
no longer supports auto-assigning unrecognized traffic.

Figure 11.5-3   Unmapped Traffic in Flows Browser

For more information about working with unmapped traffic, see Unmapped 
Traffic on page ITU-11-21 of the User Guide.

When there is 
unmapped traffic after 
an import, the Flows 
Browser displays the 
ambiguous and 
unknown sources and 
destinations.

Select the Show 
Unmapped Traffic 
checkbox any time 
after the import to 
assign unmapped 
traffic flows.
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ToS Aggregation of Flows from NetScout nGenius

Traffic-flow imports now support ToS aggregation. The Import Traffic Flows 
dialog box (Traffic > Import Traffic Flows > From NetScout nGenius) includes 
an “Include Type of Service in Aggregation” option. If this option is enabled, the 
import engine divides traffic into separate flows based on ToS levels. 

Glitch Removal of Imported Traffic/Link-Load Data

The traffic import engine now accounts for possible glitches in traffic data due 
to clocking issues. In previous releases, clocking inconsistencies could result in 
intermittent fluctuations in traffic levels. The current release factors out these 
fluctuations without affecting actual changes in traffic levels. 

Figure 11.5-4Effects of Glitch Removal on the Same Traffic Data

Guru applies glitch removal only to data in which the traffic was recorded at 
uniform intervals (for example, every 10 seconds). Specifically, Guru applies 
glitch removal to the following types of data:

• Traffic flows from NetScout nGenius

• Link loads from Concord, InfoVista, HPOV Performance Insight, and MRTG

Two preferences are included to control the glitch-removal behavior:

• traffic_import_glitch_removal (boolean)—If TRUE, the import engine 
performs glitch removal on imported traffic. This preference is TRUE by 
default; there is no reason to set this to FALSE unless you want to see how 
turning off this behavior affects the imported traffic, or to match the import 
behavior in previous releases of Guru.

• traffic_import_glitch_removal_multiple (double)—The multiple used when 
rounding the time values during glitch removal. In most cases, you can leave 
this preference at its default setting. If the clock used when capturing the 
traffic was very inconsistent, however, you might need to set this to a higher 
value. (In general, larger clock inconsistencies result in larger glitches when 
the data is imported into Guru.)

Traffic imported without glitch removal Traffic imported with glitch removal

Imported 
data 

records 
traffic at 
approx. 

10,000 bps
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Discrete Event Simulation

Radio Transceiver Pipeline Changes

The default radio transmitter antenna gain (dra_tagain) and radio receiver 
antenna gain (dra_ragain) stages have been modified to work with both 
right-handed and left-handed reference frames. In addition, support for an 
ellipsoid earth model has been added. For details, see Default Transmitter 
Antenna Gain Model (dra_tagain) on page WM-10-52 of the Wireless Module 
User Guide.

Dual MSFC Devices

See Dual MSFCs on page RN-11.5-32 for discrete event simulation (DES) 
support for Cisco 6500 dual Multilayer Switch Feature Cards (MSFC).

AODV Hello Efficiency

The default value for the DES global attribute, “AODV Hello Efficiency”, has 
changed to “disabled”. This attribute is used in MANET models using the AODV 
routing protocol to control the exchange of hello messages between neighbors. 
If the value is set to “disabled”, the neighbors may exchange periodic hello 
messages, allowing for the detection of link failures. Therefore, you may notice 
increased AODV control traffic and simulation run-time due to increased traffic 
between neighbors. 

Simulation Information Reporting

A new utility object lets you save the details of a discrete event simulation to a 
text file, which can be opened in a spreadsheet program (recommended) or text 
editor. The output file records the following information about a simulation:

• Number of seconds needed to run

• Number of events

• Amount of memory used

• Simulation duration

• Project and scenario name

• Build of core software used

• Location of output file

• Time that simulation was run
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Figure 11.5-5   Simulation Info Export Utility

By default, the output file is named default_sim_info_output.txt, but 
you can specify a different file name. The output file is always stored in the same 
directory as the project. You have the option of creating a new file each time you 
run a simulation or appending the information from new simulation runs to an 
existing file. The following table briefly describes the configuration options 
available for this feature.

If you use the default settings for this utility in all your simulations, a single output 
file is used to store the simulation information from all scenarios in the same 
model directory. Using the default settings results in larger output file sizes over 
time, but lets you store information from many simulation runs—and across 
multiple scenarios—in a central location.

Table 11.5-1 Attributes of the Simulation Info Export Utility Object

Attribute Description

Collect Simulation Information Turns this export feature on or off.

Output File Name of the file that stores the simulation information. If the 
file does not yet exist, it is created at the end of the next 
simulation. The output file is created in the same directory 
as the project file.

Write Mode Specifies whether or not information from previous 
simulations is retained in the output file. 

• Overwrite discards the existing output file (if available) 
and creates a new file that contains information from the 
latest simulation only.

• Append adds the information from the latest simulation to 
a new row at the end of the existing file. A new file is 
created if one does not already exist. 

End of Table 11.5-1
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Flow Analysis Enhancements

Standard and Specialized Model Suites

The Flow Analysis module has been enhanced to support new features in the 
following model suites. Details can be found in the Model Library Enhancements 
section of this document.

• ATM Enhancements on page RN-11.5-32

• Dual MSFCs on page RN-11.5-32

• IP Model Enhancements on page RN-11.5-34

• IP QoS Enhancements on page RN-11.5-34

• MPLS Model Enhancements on page RN-11.5-35

VoIP Readiness Assessment

The Flow Analysis module and the Planning and Design module now include a 
utility that lets you analyze the impact of voice over IP (VoIP) traffic on an 
existing network. Both modules are needed to use this feature. 

The VoIP Readiness Assessment workflow uses an easy-to-use interface that 
guides you through the set up and configuration of VoIP traffic in a network. You 
can deploy new (proposed) flows or analyze only the existing VoIP flows in the 
network. The assessment uses several iterations of flow analysis and one or 
more design actions to generate a comprehensive web report on the network’s 
readiness for VoIP traffic deployment.
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Figure 11.5-6   Web Report VoIP Readiness Assessment

In addition to the web report, you can also view the results of the flow analysis 
and design action runs.

For additional information, see Chapter 5 Using VoIP Readiness Assessment 
on page FA-5-1 of the Flow Analysis User Guide.

These links 
take you to 
detailed 
reports
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New Module: ACE Advanced Console

The ACE Advanced Console enables you to perform “continuous captures” of 
application traffic. Continuous captures are useful when you are troubleshooting 
an intermittent problem in your network or application: you cannot predict when 
the problem will occur, and therefore do not know exactly when to start or stop 
a capture in order to catch the problem. To address this case, you can configure 
agents to perform continuous captures. When the problem of interest occurs, 
you can examine the captured traffic in ACE, find traffic that relates to the 
problem, and download a capture file that includes only the relevant traffic.

For more information, see Chapter 5 Continuous Captures with the ACE 
Advanced Console on page ACE-5-1 of the ACE User Guide.

ACE Module Enhancements

Cisco Network Analysis Module (NAM) Support

You can now capture traffic in ACE using the Cisco Network Analysis Module 
(NAM). The user interface for using NAM blades and ACE capture agents is 
virtually identical: you can add and configure NAM blades, run captures, and 
download NAM data files directly from the ACE Capture Manager.

For information about supported versions of Cisco NAM, go to 
http://www.opnet.com/support and follow the “System Requirements” link. For 
information about capturing traffic in ACE, see Chapter 4 Capturing Traffic 
Using ACE on page ACE-4-1 of the ACE User Guide.

Visualization Enhancements

ACE includes a new Visualization operation (View > Visualization) that enables 
you to apply different coloring and labeling schemes to the Data Exchange 
Chart. You can apply different visualization schemes to highlight different types 
of information in a transaction. This release includes four different visualization 
schemes:

• Size—Color packets/messages by application payload size (the visualization 
used in previous versions of ACE)

• Size and Retransmissions—Color packets/messages by application payload 
size; label retransmitted packets in the Network chart

• TCP—Color network packets based on retransmissions, dataful packets, 
and SYN/FIN/ACK messages; label retransmitted packets in the Network 
chart

• HTTP—Color packets/messages based on HTTP response-code type, 
Get/Put message, and transmitted data. 
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You can configure the HTTP visualization to label specific packets/message of 
interest (choose View > Configure Current Visualization with the HTTP 
visualization selected).

ACE Decode Module (ADM) Enhancements

Updated Decode Engine

ACE now uses Ethereal to provide detailed protocol decodes of over 700 
protocols.  New decodes include FIX, VoIP, and SSL. 

HTTP Decode Enhancements

The HTTP decoder includes the following enhancements:

• Enhanced decode summaries—In some cases, the decode summary shows 
additional information (such as “[Chunked],” “[Incomplete Chunk Data],” 
“[Partial Entity Body],” or “[Incomplete Entity Body]”) that shows how a packet 
was transmitted. 

• Enhanced decode details—Decode details show additional information, 
especially about chunking behavior.

• Normalized HTTP headers in decode details—This means that header 
names always appear in lowercase, colons (:) are used for nonstandard 
name/value separators, and extra spaces are removed.

• HTTP pipelining support—The HTTP decoder and transaction analyzer now 
support pipelined HTTP messages. This means that

— Decode summaries indicate packets that contain multiple requests or 
responses.

— The same application messages might appear in more than one 
transaction.

— The decode details include additional information about each request or 
response.

QuickView Enhancements

The QuickView window now includes an enhanced set of protocol-filtering 
options and a time slider. This makes it easier to filter out packets that are 
outside the time window of interest or do not contain a specific protocol. 

Capture-Agent Enhancements

The 3.1 versions of the capture agents are now available for Windows and 
Solaris. These agents support encrypted captures and include many problem 
fixes. In addition, 3.1 agents are available as beta releases for the following 
platforms:

• HP/UX
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• Mac OS X

• Linux 2.4 and 2.6 kernel (PathProbe is not supported for the 2.6 kernel)

To obtain a beta agent, contact OPNET Technical Support (e-mail 
support@opnet.com or go to http://www.opnet.com/support).

Japanese Language Reports

ACE can now generate Japanese-language versions of ACE MS Word reports, 
ACE Multiple-Transaction reports, and ACE Comparison reports. ACE also 
includes an open reporting architecture that enables you to add custom support 
for other languages.

Miscellaneous Enhancements

This release also include the following enhancements:

• Estimating tier locations estimate during import—The Specify Tier Locations 
dialog box now includes an Estimate Locations button. When you click this 
button, the import engine estimates whether each tier is local or remote to the 
capture agent (based on the delay times of ACK messages). This feature 
helps automate the import workflow and makes it easier to create accurate 
ACE files.

• Go to Frame operation—The Find Packets (Edit > Find Packets) dialog box 
now includes a Go to Frame field that you can use to view packets in the 
Protocol Decode Viewer.

• Excluding/deleting other packets/messages in the Protocol Decode 
Viewer—You can now exclude and delete other packets/messages when the 
“Group by” option is set to Frames.

Automation Module Enhancements

Automated Import of Traffic Flows from Spreadsheet Files

With an Automation module license, importing traffic flows from a spreadsheet 
file can now be automated by creating an automation task. To create an 
automation task, choose Traffic > Import Traffic Flows > From Spreadsheet… 
For more information, see Viewing and Editing Traffic Flows in a Spreadsheet 
on page ITU-11-31 of the User Guide.

This enhancement includes the following new spreadsheet import preferences:

• flow_spreadsheet_import_filename—Specifies the default file name used 
when importing spreadsheet traffic.

• flow_spreadsheet_import_overwrite—Specifies the default choice for 
overwriting traffic when importing spreadsheet traffic.
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NetDoctor Enhancements

Reporting Enhancements

Device-Centric Reports

This release now supports device-centric reporting for all report types. You have 
the option to view device-centric information from a tab on a web report or to 
select and view a device-centric MS Word report (in concise or detailed formats) 
as an output format. Device-centric reports display the list of rules that are 
violated for each device. See Table 11.5-2 for a list of the available report types 
and formats by release.

Enhanced Visual Display for Pie Graphs and Bar Charts

NetDoctor supports a new charting package for enhanced visual display for both 
pie and bar charts.

Internationalization

NetDoctor now supports both Web and MS Word reports in languages other 
than English. Download the available language libraries from the OPNET 
Support Center (www.opnet.com/support). Check for the latest versions of the 
libraries after new releases of the OPNET software. The most up-to-date 
language libraries may lag the most recent OPNET software release.

Report Comparison

NetDoctor Report Comparison in this release is not valid for reports generated 
from previous releases. If you enable Report Comparison using a report 
generated from a previous release, the resulting report shows all rule output as 
different. Enable Report Comparison only for reports generated by this release.

Table 11.5-2 Available Report Types and Formats

Report Type Format Available in Release

Rule-Centric Detailed MS Word

Web

10.0 or later

10.0 or later

Rule-Centric Concise MS Word

Web

New in 11.5

11.0 or later

Device-Centric Detailed MS Word

Web

New in 11.5

New in 11.5

Device-Centric Concise MS Word

Web

New in 11.5

New in 11.5

End of Table 11.5-2
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Notification Plug-ins

The Notification plug-ins no longer require an Automation module license.

This release provides three new notification plug-ins (see Table 11.5-3). 

If you want NetDoctor to send other types of notifications, you can write your 
own plug-in using the open notification architecture. Notification settings appear 
on the Notification tab in the Configure/Run NetDoctor dialog box.

This release has a new advanced checkbox in the Notification tab of the 
Configure/Run dialog box. When you select this checkbox, additional 
parameters are available to edit.

NetDoctor Rules

Device Configuration File Validation Rules

Device configuration file validation rules now support matching commands in 
specific sections of configuration files. For example, you can now specify match 
or no match commands for specific types of interfaces in your network.

Rule Removed

The Organizational Policies: Missing Prefix Filters rule has been removed. If you 
are currently using this rule, please contact OPNET Technical Support (e-mail 
support@opnet.com) for more information.

Customizing NetDoctor

Charting

NetDoctor supports a new charting package with enhanced visual display for 
both bar graphs and pie charts. NetDoctor utility functions for creating bar 
graphs and pie charts have been updated to use the new package.

Table 11.5-3   Available Notification Plug-ins

Notification Plug-in Available in Release

Email (SMTP) 10.5 or later 

SNMP Trap New in 11.5

Syslog New in 11.5

Trouble Ticket (Remedy) New in 11.5

End of Table 11.5-3
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API Enhancements

This release supports the following new functions and methods:

• Ip.default_redist_metric_exists()

• Ip.get_default_redist_metric()

• Node.get_machine_type()

• Node.vendor_model()

The API documentation has been reorganized into four general categories: 
Model Access, IP Graph, Reporting, and Simulation.

Planning and Design Module Enhancements

New Design Action: IP QoS Configuration

You can use the ip_qos_configuration design action to configure IP QoS 
parameters on routers in the network model. You can define QoS configuration 
templates and apply them to specific nodes and interfaces. QoS definitions in 
the design action (of traffic classes, traffic policies, queue profiles, and interface 
QoS schemes) are added to, but do not replace, existing definitions in the 
network. The only exception is if two definitions have the same name; in this 
case, the design action overwrites the existing definition. 

New Design Action: IP QoS Queue Sizing

You can use ip_qos_queue_sizing design action to size the queue bandwidths 
or weights on IP interfaces based on the queue load and queue configuration 
rules. This design action uses Flow Analysis to compute the offered load to each 
queue based on the traffic flow. The design action attributes control how 
different queues are sized. 

New Design Action: Project Pricing Reporter

You can use the project_pricing_reporter design action to generate detailed 
cost reports for proposed upgrades, build-outs, and other project plans. You can 
create highly detailed cost models, then apply a cost model to the links and 
nodes in a scenario. The project_pricing_reporter design action then generates 
a detailed report based on the cost model and the current network. 

For more information, see Chapter 8 Project Pricing Reporter on page DA-8-1 
of the Planning and Design User Guide.
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Viewing Results and Log Messages from Previous Runs

In previous releases, you could view results and log messages for the last run 
only. Now you can view results and log messages for different design action 
runs from the current Guru session or from previous sessions. The names of 
both the result files and the log files include the project-scenario and the design 
action. This means that you can view results/logs for different design action runs 
(if you run the same design action multiple times in the same scenario, however, 
only the last run is saved). 

To support this enhancement, the Design > Results submenu has options for 
viewing the latest results/logs (View Latest Log and View Latest Results) and 
for viewing results from previous runs on the current project/scenario (View 
Logs and View Reports).

For more information about the operations available on the Design > Results 
submenu, see Design Menu on page DA-1-3 of the Planning and Design User 
Guide.

Format for link_pricer_custom_db

The format for the link_pricer_custom_db file is now documented in the 
link_pricer_custom_db_example.gdf file. To view this file, do the 
following:

1) Choose File > Open.

2) From the “Files of type” pull-down menu, select Generic Data File.

3) Select the Show all files of type “Generic Data File” checkbox to list all .gdf 
files.

4) Select the link_pricer_custom_db_example.gdf file and click the 
Open button.

Additionally, the product ships with a sample project (Greenfield_Design) that 
demonstrates the use of the link pricer custom database.

Terrain Modeling Module

Several enhancements have been made to TMM.

Improved Simulation Performance

Simulation performance when using detailed terrain data (for example, 
10-meter resolution) has been significantly improved.
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Updated Longley-Rice Algorithm

The algorithm used for the Longley-Rice propagation model has been updated 
from version 1.2.1 to 1.2.2.

CADRG/CIB Map Support

TMM enables you to display CADRG (Compress ARC Digitized Raster 
Graphics) and CIB (Controlled Base Image) data in the Project Editor. A 
background display based on actual geographical data can enhance the visual 
appearance of networks and make it easier to place objects in the correct 
geographic locations.

For more information, see Displaying CADRG and CIB Maps on 
page TMM-2-12 of the Terrain Modeling Module User Guide.

TIREM Module

The TIREM module now contains the TIREM4 propagation model in addition to 
TIREM3. TIREM4 is an optimized version of TIREM3 that provides faster 
computation of path loss values, especially for detailed terrain profiles. Owners 
of the TIREM module will have access to both TIREM3 and TIREM4 wherever 
a propagation model can be selected.

For more information about TIREM, see TIREM Propagation Model on 
page TMM-2-4 of the Terrain Modeling Module User Guide.

Wireless Module

A new preference—network_visualization.hide_trajectories—controls display of 
trajectories in the GUI.

3DNV Module Enhancements

Simplified Entity Mapping

Adding the 3DNV mapping extended attribute to nodes and subnetworks is now 
as simple as choosing Topology > 3DNV > Add ‘3DNV’ Mapping Attribute to 
Selected Nodes. For details, refer to Default OPNET/3DNV Mapping on 
page AV-5-3 of the Animation Viewers Reference Manual.
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Visualization of Site Trajectories

In Planning Mode, you can now use 3D Network Visualizer to view the 
trajectories assigned to network sites. This lets you see the trajectory a site will 
follow in direct relation to the terrain being traversed. A trajectory displayed in 
3D Network Visualizer is automatically updated when the site is moved or the 
trajectory is edited in Guru. For details, refer to Visualizing Trajectories in the 3D 
Network Visualizer on page AV-5-7 of the Animation Viewers Reference 
Manual.

Faster Entity Attachments

When using 3DNV in Planning Mode, you can quickly switch the Visualizer 
window to a specified entity by right-clicking on the corresponding object in Guru 
and selecting the new “Attach to Entity in 3D Visualizer” operation.

Preferences

The following new 3DNV preferences are available in Guru:

• 3dnv.max_request_rate—Specifies the maximum number of animation 
requests per second sent to 3D Network Visualizer. This setting can help 
prevent 3DNV from becoming overloaded by too many messages in a short 
period of time.

• 3dnv.show_opnet_overlay—Specifies whether IT Guru-specific overlay 
information (such as the network name) should be shown in the 3D Network 
Visualizer window.

• 3dnv.trajectory_sampling_distance—Specifies the size of the line segments 
used to draw trajectories whose altitude is relative to terrain altitude.

• 3dnv.trajectory_thickness—Specifies the thickness (in pixels) of the lines 
used to represent a trajectory.

Model Library Behavior Changes

Default Metrics for Redistribution

Most imported and manually created projects will generate different results 
because of new values for the default metrics used for redistribution. For 
example, flows that were routable in previous releases might no longer be 
routable.
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Unless metrics have been explicitly defined in the device configuration files for 
imported devices or manually in the Redistribution attribute, the following 
metrics are used for redistribution. In Table 11.5-5, “None” indicates that 
redistribution does not occur—even if redistribution is enabled. 

Table 11.5-4   Default Redistribution Metrics for all Routers (Except Juniper)

Redistribution Into

BGP EIGRP/IGRP ISIS OSPF RIP

BGP n/a none 0 1 none

EIGRP/IGRP same as RP 1

1 . Same as redistributed protocol.

native metric 0 20 none

ISIS same as RP1 none same as RP1 20 none

OSPF same as RP1 none 0 same as RP1 none

RIP same as RP1 none 0 20 same as RP1 

Connected 0 formula 2

2 . There is a factor of 256 between IGRP and EIGRP in the composite metric computation.

0 20 0

Static 0 256/1 0 20 0

End of Table 11.5-4

Table 11.5-5   Default Redistribution Metrics for Juniper Models

Redistribution Into

BGP
EIGRP
IGRP ISIS OSPF RIP

BGP n/a n/a 10 same as RP 1 

1 . Same as redistributed protocol.

1

EIGRP/IGRP n/a n/a n/a n/a n/a

ISIS same as IGP 2

2 . Same as IGP route metric.

n/a same as RP1 same as RP1  1

OSPF same as IGP2 n/a same as RP 3 

3 . Same as redistributed protocol (max 63)

same as RP1 1

RIP same as IGP2 n/a same as RP1  same as RP1  same as RP1 

Connected 0 n/a 10 0 1

Static 0 n/a 10 0 1

End of Table 11.5-5
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Default Interface Information for Cisco Routers

The following parameters (bandwidth, delay, MTU, reliability, load) are used to 
compute the default metric when redistributing directly connected interfaces into 
EIGRP/IGRP. Bandwidth and delay are dependant on the interface type.

Send-Community Attribute for BGP-MPLS VPNs

In this release, discrete event simulation now explicitly checks the BGP 
send-community attribute to determine whether to keep or strip the route target 
extended communities from BGP updates on BGP-MPLS VPNs. This behavior 
in the model is the same as the behavior on production networks.

Removal of DSR Model Attribute: Request Holdoff Time

The Request Holdoff Time attribute (AD-HOC Routing Parameters > DSR 
Parameters > Route Discovery Parameters > Request Holdoff Time) is no 
longer a configurable parameter of the DSR model. In previous releases, this 
attribute was used to limit the number of route requests (RREQs) sent to each 
destination. 

The removal of this attribute addresses a discrepancy between the model and 
the DSR draft. The DSR draft does not include a configurable parameter to limit 
the RREQ rate, but instead uses an exponential backoff timer during route 
discovery to limit number of RREQs generated for each destination. In this 
release, the model limits the RREQ rate as described in the DSR draft. As a 
result of this change, you might see less DSR control traffic or an increased 
route discovery time compared to previous releases (especially for scenarios in 
which the data packet arrival rates are high).

Table 11.5-6   Default Values for Calculating Redistribution Into EIGRP/IGRP

Bandwidth 
(Mbps)

Delay 
(µsec) MTU (bytes) Reliability Load

Eth/Fasteth/Giga 10/100/1,000 1,000/100/10 1,500 255 255

FDDI 100 100 4,470 255 255

Token Ring 4/16 100 4,464 255 255

ATM 25 80 4,470 255 255

FR 1.544 20,000 1,500 255 255

IP 1.544 20,000 1,500 255 255

Loopback 8,000 5,000 1,514 255 255

Tunnel 0.9 500,000 1,514 255 255

VLAN 10 1000 1,500 255 255

End of Table 11.5-6
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Model Assistant File Conversion

If you have a model assistant file containing networks imported through device 
configuration import (DCI) from previous versions of Logger, you must convert 
your file prior to using it in 11.5. A new conversion utility, op_ma_conv, is 
included in 11.5. The following flags are available to convert individual files, a 
list of files, or all files:

WARNING—If you do not convert your pre-11.5 model assistant files containing 
networks imported through DCI, they will not work in 11.5.

Model Library Enhancements

ATM Enhancements

The ATM model suite now includes the following features for flow analysis (no 
change to supported features for discrete event simulation). 

• Slot-port support 

• Per-class load balancing for Nortel devices 

• New reports on delays for PVCs 

Dual MSFCs

Support for Cisco Catalyst 6500 multi-layer switches with dual Multilayer Switch 
Feature Cards (MSFCs) is enhanced for device configuration import (DCI), 
Virtual Network Environment (VNE) Server, discrete event simulation (DES), 
and flow analysis. These multi-layer switches are imported as a multi-module 
switch type device and are used in DES and Flow Analysis.

Two new “show” commands are supported that allow you to model dual MSFCs:

• show module 

• show redundancy

Table 11.5-7 Flags for op_ma_conv Utility

Flag Usage

-all (default) Converts all model assistant files in 
the model directory. If no flag is provided, the 
utility converts all files.

-m <model name>, <model name>, ... Provide individual filename or a list of 
filenames separated by commas. Enter the 
filename without the .ma extension.

End of Table 11.5-7
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Redundancy information and configuration attributes of the non-designated 
MSFC in the dual configuration are now stored in the new MSFC compound 
attribute.

DES and Flow Analysis

DES and Flow analysis support dual MSFCs with the following requirements:

• “Config-sync” is enabled.

• MSFC failover in the network model is not supported; both MSFCs are 
assumed to be up or both MSFCs are down.

• Routing simulates a network that has either both MSFCs running (with no 
failover) or both MSFCs down (device failure).

IP routing:

• Both MSFCs can serve as sources/destinations to simulate the following:

— ICMP (ping)

— IP traffic flows

For HSRP:

• One HSRP process runs on the device using the MSFC with the higher 
interface priority.

• HSRP uses the preemption status and delay of the MSFC with the higher 
interface priority (DES only).

• The HSRP traffic sent from the dual MSFC is half the traffic seen in the live 
network (DES only).

For BGP:

• There is one incoming and one outgoing BGP connection on the designated 
MSFC for each BGP neighbor.

• No BGP process runs on the non-designated MSFC.

• The BGP control traffic is less than the traffic seen in the live network (DES 
only).

• The simulation uses the policies configured on the designated MSFC for both 
BGP neighbors.
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IP Model Enhancements

The IP model now supports the following enhancements:

• Ability to compare forwarding tables generated from the following sources: 
operation network, flow analysis, and discrete event simulation. The reports 
generated by the comparison let you organize the changes (mis-matches, 
additions, and deletions) from a prefix perspective or a device perspective. 
To compare forwarding tables, choose IP > Routing > 
Forwarding Table Comparison.

• New menu operations for auto-addressing IPv4 and IPv6 interfaces under 
Protocols > IP > Addressing.

Figure 11.5-7   IP Automatic Addressing Options

For additional information on these features, see Chapter 9 IP Model User 
Guide on page STM-9-1 of the Standard Models User Guide.

IP QoS Enhancements

The IP QoS (Quality of Service) model suite now supports flow analysis. In 
previous releases, this model supported only discrete event simulations. If you 
have already configured QoS in a network model, no additional configuration is 
needed to run flow analysis instead of discrete event simulation. 

For additional information about the current model, see Chapter 11 IP QoS 
Model User Guide on page STM-11-1 of the Standard Models User Guide.

IPv6 Model Enhancements

The IPv6 model includes the following enhancements:

• Ability to automatically assign IPv6 link-local and global addresses to the 
physical and loopback interfaces of all nodes in network

• Ability to configure traffic demands between IPv6 interfaces

• Support for OSPFv3 as a routing protocol for IPv6 networks
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• New visualization options:

— Ability to view the interfaces running IPv6 in the Project Editor workspace

— Ability to view the IPv6 tunnels configured in the network in the Project 
Editor workspace

• New menu operations under Protocols > IP > IPv6 to simplify IPv6 
configuration:

— Auto-Assign IPv6 Addresses

— Clear IPv6 Addresses

— Configure Interface Status

— Enable IPv6 on All Interfaces

— Enable IPv6 on All Interfaces

For additional information on these features, see Chapter 3 IPv6 Model User 
Guide on page SPM-3-1 of the Specialized Models User Guide.

MANET Model Enhancements

The MANET model has been enhanced to support the following:

• Support for OLSR in IPv6 networks

MPLS Model Enhancements

The MPLS model has been enhanced to support the following:

• DiffServ-aware traffic engineering

• Improved workflow for deploying MPLS VPNs

• Inter-domain routing (flow analysis only)

— Inter-area LSPs (for Cisco routers)

— Inter-AS LSPs (for Juniper routers)

— Cross-connect circuits, CCCs (for Juniper routers)

For additional information on these features, see Chapter 5 MPLS Model User 
Guide on page SPM-5-1of the Specialized Models User Guide.
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SMART MAC

The new SMART MAC model provides an abstraction to the Wireless MAC and 
PHY layers. The model includes the following features:

• Medium access contention delays due to:

— Retransmissions caused by interference, radio frames collision and other 
physical layer effects

— Backoff effects

• Packet drops due to:

— Retransmission threshold

— Buffer overflow

— Collisions due to hidden nodes

• Reachability changes due to node mobility and node transmission ranges.

For additional information about the SMART MAC model, see 
Chapter 23 SMART MAC Model User Guide on page STM-23-1 of the Standard 
Models User Guide.

OSPF Model Enhancements

The OSPF model suite now supports OSPFv3. OSPFv3 is the version of OSPF 
used in IPv6 networks. Previously, the model supported only OSPFv2, which is 
the version of OSPF used in IPv4 networks. Like the IPv6 model suite, OSPFv3 
is supported for discrete event simulations only. Flow analysis does not support 
OSPFv3 at this time. 

The following OSPFv3 features are supported:

• Point-to-Point, Broadcast, Point-to-Multipoint, and Non-broadcast interface 
types

• Multiple areas

• Area summarization

• Link-state database export

Use the following steps to configure an IPv6 interface to use OSPFv3:

1) Enable OSPFv3 for the IP > IPv6 Parameters > Interface Information > 
Routing Protocols attribute for the interface.
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2) Set the OSPF version to “v3” for the OSPF process running on the 
interface. The version attribute is located under IP Routing Parameters > 
OSPF Parameters > Processes > Version.

3) For routers that use IPv6 only (no IPv4 interfaces), specify the Router ID 
attribute.

For additional information about the OSPFv3 model, see Chapter 18 OSPF 
Model User Guide on page STM-18-1 of the Standard Models User Guide.

Wireless LAN Model Enhancements

The Wireless LAN model has been enhanced to support the following:

• HCF EDCA. The HCF EDCA mechanism of IEEE 802.11e is now supported. 
You can configure HCF parameters in the new Wireless LAN Parameters > 
HCF Parameters attribute. Many of the Wireless LAN global and node 
statistics can now be collected according to HCF access categories. These 
statistics appear in a new statistic group, WLAN (Per HCF Access Category).

• QoS. The QoS facility of IEEE 802.11e is now supported.

• WLAN Beacon Transmission Count. The WLAN Beacon Efficiency Mode 
simulation attribute has been replaced by the WLAN Beacon Transmission 
Count simulation attribute. The new attribute still lets you disable beacons in 
Wireless LAN networks. This is useful in an infrastructure BSS, where 
periodic beacons are not needed. To enable this efficiency feature (and limit 
the number of regular beacons), set this attribute to the number of beacons 
to transmit during the simulation. A value of “Periodic” disables this efficiency 
mode and corresponds to a value of “Disabled” for the old attribute.

The attribute and statistic changes mentioned here are reflected in architectural 
changes (process models, packet formats, and so on) in the model suite. For 
more information about the current model, see Chapter 31 Wireless LAN Model 
User Guide on page STM-31-1 of the Standard Models User Guide.
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